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The Keyboard							Lesson1

The Backspace Delete key.  Used for deleting characters to the left.
The Enter key is used for entering data into the computer.
It “Starts a new line”.
Also called the Return key.






The Delete key.  (The one with Delete written on it!). Used for deleting characters to the right.
The Caps Lock key.  Press it once and then you can type in caps.  Press it again and you’re back to lower case.
(Note the Caps Lock light at the top right of the keyboard indicates whether this is on or off.)






[image: http://marcom.aopen.com.tw/pics/input/kb823.jpg]Space bar.  Makes a space!














The Shift Key.  Hold it down to type capitals. 


Ctrl key –used in combination with other keys  - (later)







Switching On

The “main box” of the computer is referred to sometimes as the base unit.

[image: BS00103_]
To switch the computer on, press the on/off switch on the base unit. (Sometimes a bit difficult to find!)






The screen part is the monitor.
[image: https://encrypted-tbn0.gstatic.com/images?q=tbn:ANd9GcRNgdSLcZSBYgOIOWHEZG5OAT1CTAsVu_fz51wa16597Ixckv1bhQ]You may or may not need to switch the monitor on as well.  Sometimes the power lead to the base unit feeds to the monitor as well in which case turning on the base unit turns on the monitor as well. 



Windows

After your computer has started up you should see something like below.

This is Windows. There are many versions of Windows (XP, 7, 8, 10 etc).  They all do much the same thing!)

Windows is used to start other things - a sort-of launch pad.

These postage stamp-sized icons you see below are called shortcuts. 

They are used to start the programs.

Word is a word-processor - used for writing letters.
(Lessons 1 & 2.)




Excel is a spreadsheet- used for doing accounts.
(Lesson 3.)

Access is a database. (Used for storing and manipulating data such as names and addresses.
(Lesson 4.)



				[image: ]Outlook Express or alternatively Outlook is used for e-mail.
(Lesson 6)
[image: ]

PowerPoint is a fancy word-processor.  Used for making brochures etc.
(Lesson 5.)


Internet Explorer (or FireFox etc) is used to surf the web. (Lesson 6.)
Windows Explorer is used for organising your letters (files) etc on your computer.  (Lesson 5.)





All of these programs Word, Excel etc are collectively called applications, or apps.

[image: ]

You may see a screen like this. This is Windows 10.
If you press this key it will open up the Start Menu (shown)

[image: ] 
This is called the Windows key.














The Desktop

If you have Windows 10 or 11 you will have a desktop looking like the image below (shown is Windows 11). This is like the “homepage” of your computer.
Some app/program/file shortcuts. Double click the large icon above the writing to open them. In Windows 10 and versions before you can drag and drop apps or files to the desktop





The Start Menu shown open




[image: ]

At the bottom running along the whole screen is your taskbar. Active programs, or ones you can ‘pin’ to the taskbar for immediate access will be in the middle.

In this corner you have a local weather and quick news access button which will open up a panew panel on the left side of your screen



In the very far bottom right hand corner is a secret button which if clicked will minimise all open apps/programs and take you straight back to the desktop

Open a few things and try it!

In the right corner if you click on the date/time it will open up a calendar and your computer’s notifications. Next to it you have settings for wifi, sound, battery and a few other options





The Taskbar


The icon for Settings!
The search tool – opens up in the start menu. Search for anything on your computer (and also web based results)





[image: ]

The “Start” button (see image previous page). This used to be in the bottom left hand corner of the screen on Windows 10 – “W10”. Opens the Start Menu. Use it to find any app/program/file, search for anything on your computer, see a list of recently used apps/files, switch off your computer safely and much more. You can also open the Start menu by pressing the Windows button on your keyboard – it looks the same as the icon.

The rest are icons for apps/programs. You can ‘pin to taskbar’ (shown below) so that the app is always available to access at anytime, even with other windows open. Otherwise it will only appear here when you have the app open.






An icon with a larger blue mark underneath, and a thin visible outline means the app is open and active on the screen





An icon with a small grey mark underneath means the app is open but minimised (not on the screen)





A Windows 10 desktop/taskbar/start menu (shown open) for comparison:

[image: ]



To Pin an app/program to the taskbar/start menu

An app will only appear on the taskbar if it is currently open, or pinned to the taskbar. Otherwise, to open it you will have to put it on the desktop (which can be hidden by open windows), or search for it/find it in the start menu list of apps. If you want it always available to you, you can pin it to the taskbar (or the start menu so that it always appears there also). To do this, locate the app in the start menu, or by searching for it. You can then either right click on the icon, or choose one of the shown options:



[image: ]Search for the app using the start menu/search tool
If you can’t see these options make sure this arrow has been clicked.
Pin to Start/Taskbar here.
You can also right click on the Word icon to see the same options





Finding and Opening an App eg Microsoft Word

If it is not yet pinned to the Taskbar, use the Start Menu (shown open below) to find the Microsoft Word App. If it is not at the top “pinned” area you can click on “All Apps” to find it alphabetically. Note that it is called “Word” and not “Microsoft Office Word” as it used to be. In Windows 10 rather than selecting “all apps” you can just scroll down the list on the Start Menu. When you find it, click on the Word icon to start Word.

(Remember you can also always just search for it in the Start Menu)

The search bar




[image: ]Recommended/ Recently opened files/documents
All Apps
Pinned/ Suggested Apps area



Your account/profile settings



The Power Button. Use this to switch off your computer. You will normally get 3 options:

Shut down – shuts down the computer entirely. If you don’t save your work, you may lose it.
Sleep – keeps the computer on, but using very low power. Useful if you want to keep some things open to immediately use when you switch on again
Restart – Restarts the computer, can be used to finish installing updates etc.







Always remember to double click the icon, not the name. If you accidentally click too slow on the [image: ]name, the computer will think you are trying to rename the program.



You will be learning more about Word later in the lesson. 

For now close it as follows:
· Place the point of the mouse arrow (the cursor) in the middle of the word File (top left hand corner) and click the left button. (Always click the left button unless instructed explicitly to click the right button).

[image: ][image: ]Click this arrow to exit the File Menu if needed

2. The File menu appears:





The File Menu. This looks very similar in Windows no matter what app you are using (just perhaps a different colour). Here you will find the general actions for the app: Create a new blank file, Open a previous file, Save your document (more on why there are two options later), info, print etc.










1. Click File.

3. Click Close.







If you have typed any text into your Word document, it will ask you if you wish to save it:

[image: ]

For now, click Don’t Save. We will cover the other options later.

Word closes.  
· Click on the cross in the top right hand corner.

Another way to Exit:

[image: ]







If you hold your mouse steady on any of these buttons you will see a description appear.  They should say:  (“Restore” may also be “Maximise”)					Close
Restore
Minimize

 		(We will discuss the other two later)


When we start a new document it appears that another copy of Word starts complete with its own menu (ribbon) etc.

There is one x button cross at the top right which is used to close each document.

[image: ]








Closing the final document closes Word as well.





Take care when attempting to double-click a shortcut to open an application.
There is a difference between double-clicking (quickly) and clicking twice.

· For the exercise Click once on the descriptive words on the shortcut and then click again.
     The words go wobbly blue.
· Type something - the words change.  Don’t press the Enter Key.  
· Press the escape key (at the very top left of the keyboard to cancel the operation.) 

To avoid this dangerous situation altogether in future, make sure that you double-click on the picture (in this case the “W” image rather that the text in this case “Microsoft Office Word 2007”).

If you do actually want to rename a program/file, you can use this method but the official way to do so is by:

[image: ]














· [image: ]Right Clicking on the icon to bring up the special menu:
· Go to Rename at the top (shown in the image – Windows 11 – W11)
· Note: In older versions of Windows “Rename” should be in the normal list rather than at the top
· Type the new name
· Press Enter or click outside of the icon to finish










To Minimise a Window

· Open a window eg Excel (by double clicking on it’s shortcut or by following the above procedure.)

Look at the buttons at the very top right of the screen (window).

[image: ]


	


· You should see Excel minimised at the bottom left of your screen (on the Task Bar) as below.· Click on the Minimise button. (The "minus" button) on the left.



[image: ]


· Click on the minimized Excel to Restore it.

You can see therefore that minimizing the application "keeps it running in the background" rather than closing it down completely.

· As an exercise, open another application eg  Notebook and minimise them both so that we have as below:


[image: ]


If you have only one file open in an app, clicking on the icon on the taskbar will open up the file again to its previous settings.

[image: ]
However, without actually clicking, you can hover your cursor over the icon on the taskbar and it will bring up a small preview at the bottom (shown on the right). If you place your cursor on this small preview – it will show you a full page preview of the document. But, if you move your mouse away it will disappear – it was just a preview. 

Click on it to open it again.




If you have more than one file open in an app, it will show you these as small previews. You can hover your mouse over each to see full page previews, then click on one when you decide you actually want to open it.

[image: ]


In general, when you are asked to start Word for example, first check to see if you have Word on the lower task bar. 

[image: ]
If you do, click on it - otherwise double-click on its shortcut on the Desktop/Start Menu/Taskbar. 







To Restore Down a Window and Maximize (to take up the whole screen)

“Restore” in this context means restore the window to the size it was previously.
The middle button of the three in the top right hand corner of the window changes depending on if the app is currently open in full screen or smaller:
· .. and the Restore (middle still) button to restore it to its previous size..
·  
· Click the Maximize button to make the window fill the whole screen…
 

						Notice that the middle button changes its appearance as well as function. 





[image: ]
[image: ]




To Move a Window Around The Screen


· First, “Restore Down” a window by clicking the middle button at the top right of the screen so that it no longer covers the whole screen.
· Click anywhere on the (usually blue if in Word) coloured Title Bar at the top of the window and drag it around before letting go (just like a playing card). To be safe – aim for where the name of the document is in the middle
· 

· 








[image: ]

Instead of using the Restore Down button to reduce it from full screen, you can actually click and drag the program down from the top (in the same way you would drag a window around). This makes the window the same size as the Restore Down button would, but allows you to place it wherever you want in the same action.

Also, take care when moving the window around the screen that you don’t accidently double-click on the Title Bar. This will have the effect of Maximizing/Restoring the window (Exactly the same function as middle Maximise/Restore Down button)

To Manually Re-Size a Window· To make the window wider, very carefully position the mouse (without clicking) over the very edge of the window.  It should change into a double arrow.  Only then, click & drag the edge to make it bigger or smaller.

(If you hold down the Shift key as you drag it will ensure that you maintain the same screen ratio.)












· To resize it horizontally, drag a horizontal double arrow right or left.






· Try the bottom (or top) edge.







· Exercise: Open two windows.  “Restore” them down. Move them around so that they overlap.
 (Cascading windows)

[image: ]If we click anywhere in the “bottom” window, it will come to the top.






Small Exercise: Position Word and Excel so that their windows each take up half the screen as shown below.  (We say that the windows are tiled)

[image: ]

Luckily, nowadays Windows has some very neat tricks to help you arrange multiple windows open at the same time. On Windows 10/11, you can drag an open window “off” one of the edges/corners of your screen and it will give you a preview of the smaller area of the screen it will take up:
If you drag a window off the right side – it shows you that it will take up the right hand side of the screen. You can do the same for each corner too:

[image: ]






[image: ]





Once you let go of the mouse, it will then ask ask you to select another open window to fill the remaining space in the scree. Click on whichever window you would like.



To Exit Windows (ie Shut down your Machine)

[image: ]				


· Click Start.  (To stop a computer!) 

· Then click the Power Icon. As mentioned before, you will normally get 3 options:

· Shut down – shuts down the computer entirely. If you don’t save your work, you may lose it.
· Sleep – keeps the computer on, but using very low power. Useful if you want to keep some things open to immediately use when you switch on again
· Restart – Restarts the computer, can be used to finish installing updates etc.









You may be presented with a screen like this if you have work which you have not saved. You can either “Force Shut Down” which may mean you will lose any work which is open (make sure it’s not important!), or you can click on each listed program to then open them and deal with them individually.

[image: ]




Note that you should never just switch the computer off when in windows.
You must exit properly as shown below.

However, in modern machines and laptops when you press the Power button once briefly it normally puts the machine into “sleep” mode which is OK.





· You can either continue the shutdown of cancel it altogether.



		

[image: Power button icon. Black, minimalist icon isolated on white background.  Power on off button simple silhouette. Web site page and mobile app design  vector element. Stock Vector | Adobe Stock]
Laptops and modern computers will also have a Power Button. Normally you can press it briefly once to send your machine into “Sleep” mode (where it is still on but using minimal power). Or, hold it for an extended period of time (often 5-10 seconds) to force the computer to restart – this could be useful if your machine has frozen and is not responding, for example.





WORD

· From Windows, start up Word in any way you like.

Below shows you what Microsoft Word 2016 looks like. Later versions will be extremely similar. Other Office programs also utilise the ribbon system so will look very similar, but will be in a different colour. Word is blue, Excel is green, PowerPoint is red, etc.

The menu items are arranged into tabs. If you click on any of these the area below the tabs (the ribbon) will change showing you the functions you have for each tab.





[image: ]This is the ribbon. All options related to the currently selected tab will appear here. The ribbon is further split into smaller sections (Clipboard, Font etc) as shown above







Note that your spelling mistakes will be underlined in squiggly red as you type. You can go through all the flagged errors one by one using the Spelling and Grammar function (covered later) This “option” can be turned off and on by going to File – Options – Proofing, but it is recommended that you keep it on.

Type any old thing on the screen. A couple of lines will do. If you are just typing nothing in particular then make sure that your “words” have spaces between them - ie not just ONE long word of typing.

The insertion point is the thick black flashing vertical line. When you press a key, the text is inserted to the left of this insertion point.



When you are typing, try and keep your index fingers near the F and J keys as shown below. Most keyboards will have little bumps on these keys for this exact reason. Try and keep your hands in roughly the same position as you type and instead move your fingers. It will be very slow progress at first but eventually when you are typing faster you will see the benefits!


[image: Standard positions of the fingers on a conventional QWERTY keyboard for...  | Download Scientific Diagram]



Moving the Insertion point

Method 1:	Using the keyboard keys.



· Press one of the arrow keys on the keyboard to move the insertion point left, right up & down. (Note that if you’ve only typed one line of text you won’t be able to go up or down!)
· If you type words in at your insertion point in the middle of a line, note that the whole of the text moves to the right and maybe onto the next line.


Method 2: 	Using the mouse

· Move the mouse about (don’t click yet)

· 
Position the I- beam using the mouse at the point where you wish to insert some text and then click. The insertion point will “follow” the I- beam.

·  Don’t move the mouse while you are clicking. If you do you will get a lot of grey stuff – the text is highlighted – we will discuss highlighting later. (To get rid of this highlighting simply click again somewhere in your document.)



To Delete a Character. Two ways:

· Press the backspace-delete key.



(At the top right of the main group of keys.) Note that this causes the deletion of the character to the left of the cursor.



· Press the delete key (the one with Delete or Del written on it). Note 		that this causes the deletion of the character to the right of the cursor.

Quick Keys


	To quickly get to the start of a line press the Home key



To quickly get to the end of a line press the End key 




To quickly get to the start of a document press Ctrl-Home key (i.e. hold down the Ctrl key (bottom left of the keyboard) and momentarily press the Home key.







To quickly get to the end of a document press Ctrl-End key (i.e. hold down the Ctrl key and momentarily press the End key.






The Enter Key:




(The shape may be a little different on your computer keyboard )



The Enter key was also known as Carriage Return or Return key.

(There is sometimes also another key on the very far right which actually has “Enter” written on it. This does exactly the same thing but is not used much!)

As you should know, when you type a lot of words the computer will start a new line for you when it reaches the far right of the screen (This is called word-wrapping )

You can of course pre-empt this and force the computer to start a new line before it gets to the far right of the screen by pressing Enter.

The Enter key can be regarded as giving the instruction “Start a new line”. In reality what it actually does is start a new paragraph. This distinction is important when dealing with the formatting of individual lines/paragraphs.

If your insertion point is in the middle of a line and you press Enter it will split the line - i.e. you have given the instruction “Start a new line”!

(To reverse this straight away, press the Backspace-delete key)

When you press Enter it is much like pressing the letter a or a space etc ie it is a character.

When you press Enter, you are inserting a character just like any other character except this is an instruction to start a new line. (Later we will see that we can actually see this character in your document! )

If you delete this character by pressing the backspace delete key then you are deleting the Enter character ie you are deleting the instruction to start a new line - and it won’t - start a new line ie the line will be moved up

Question: How would you move all your text down the screen using the Enter key?

· ans: Place the cursor at the start of your document and press Enter a few times.

How would you move it back up again?

Hint: Use one of the delete keys. Which one you use depends on where your insertion point is!



Using the Tab Key

To help us understand the tab key more, make sure the Ruler is visible underneath the ribbon.

If the ruler is not visible, click on the View tab, then Ruler on the ribbon in the Show section.




[image: ]This is the Ruler. The grey areas at each end are the margins of the current page. These can be changed.





[image: ]
The ruler from an older version of Word is shown above. Note the little grey marks beneath the number. However, they may not be there as this has been removed in later versions of Word.

These are the tab marks. They are presently set every half inch (or centimeter though we can change this in the options.)

Press the tab key (the “double-arrowed” key near the top left of the keyboard above the Caps Lock button.)

Note that when you press this tab key, the cursor in the document moves in jumps to beneath these marks, moving the same distance each time

In general, it is much better in word-processing to use tabs as much as possible rather than using spaces to set out your document if you want to align words/columns of words correctly.

Use the tab key to produce something like this:

[image: ]

Use the tab key to make sure the columns are aligned! Note that you need to press Enter to get to a new line.


The Show/Hide button

The Show/Hide button is a very useful function in Word. With it on, you will get funny “marks” all over your screen. This shows you the formatting of the document – each time you press Enter, tab, space, etc. It even shows you when you start a new page, or a new section and lots more!

The marks will not appear when you print your document, so it is recommended to have it switched on when you are editing your document.The button is found in the Paragraph section of the Home tab



Your screen may appear something like this:

[image: ]This shows you have started a new page
The strange     character denotes the press of the Enter key
The small dot indicates a space.
Each arrow is where you have pressed the tab key











The Nature of all Word-Processors

You start a new document.

You type some text.

You want to move the cursor to near the bottom of the screen to type “Yours Sincerely”.

The cursor moves down to where you click or press the down arrow keys - right? Wrong!  Why not?

You look at your almost-blank screen - it’s the same as a blank sheet of paper and you can write anywhere - right? -wrong!

You must first extend your document by pressing Enter many times.

In later versions of Word you are now however able to double click in a blank area of the document and it will create the space required. If you have clicked in the middle of the page it will also create a custom tab on that line to put you where you wanted to go. But – without the Show/Hide button on you wouldn’t know how it has done this!


[image: ]


To Set the Margins

The margins are pre-set to 1” either side but you can change this if you really want to.

The margin setting will apply to the whole document. (We will see later that paragraph indents apply paragraph by paragraph.) You can however change the margins on just one page by using Section Breaks (another course)

To Set the Side margin

Make sure that your horizontal ruler is visible at the top of the page.
· Move your cursor to between these two little triangles. A double headed arrow should appear when you are in the right. This is not easy – be patient!
· Don’t click until you see the double headed arrow otherwise you will edit something else completely!






If the horizontal ruler across the top is not visible, click View, Ruler.

[image: ]


· Drag to the right. (Don’t drag the triangles!). Your left margin (the grey area) should increase.

The difference is more noticeable if you zoom out to see the whole page. There are a few ways to do this.

A quick way is to look for the zoom bar in the bottom right hand corner of the window:

You can also click anywhere along the zoom line or click and drag the vertical bar to the left or right. But be careful! This method can be hard to control.

[image: ]
Print Layout view. This is standard.
The easiest way to zoom in or out is to click on the + or – signs to incrementally change the zoom



The other way is to use the Zoom are of the View tab
· One Page will zoom out so that the height of the page fits perfectly in the window.
· Multiple pages is similar but you need more than one page to see the benefits. It will zoom out to show you numerous pages side by side
· Page width will zoom in so much that the width of the page takes up the width of the window.
· Try the other options too! 

[image: ]


To Set the Top margin


Make sure that your ruler is visible down the left hand side.

(For the rulers to be visible you must also be in Print Layout view.) 

[image: ]





· Move our cursor over this boundary until the double-headed arrow appears and then drag.
· Tip of the day: if you also click and hold down the right button on the mouse, it will give you the actual measurements!












If you are using headed note paper in your printer you may want to set your top margin to 2.5 “ for example.

[image: ]You can also create your own custom margins!
To change all four margins at the same time, go to the Layout tab, then the Page Setup section and click on Margins.



To Start a New Page

Make sure that you are at the end of your document (Ctrl-End), or that your insertion point is correctly positioned where you want to start a new page (everything after the insertion point will be pushed onto the next page)

Press Ctrl-Enter.

You will see something like this (if you are in Print Layout View and have the Show/Hide button on).

[image: ]This Page Break tells you that a new page has been inserted here



Note that if you have adjusted the margins for the first page then the margins on all subsequent pages will be the same.

Change the view settings to “Multiple Pages” and verify this.

[image: ]You can also perform a Page Break via the Insert tab, Pages section, Page Break.
Make sure your Insertion Point is in the correct place first!




Why is using a Page Break useful? You could just use the Enter key to keep inserting new lines until you reach a new page. But, there are numerous issues with this. The main being that using a Page Break preserves the formatting of everything after it. 

If you use the wrong method – i.e. using the Enter key – if you go back and edit the document before this new page, you will be affecting the formatting of the entire document after this new page. All of the rest of your document will be getting pushed around as you continue to type and you will not even know! When you return it may not look anything like it was before.

With a Page Break, no matter what you do to the document before this Page Break, it will not affect anything after it.

In the image below (created using the Multiple Pages view), the second page has been created using the Enter key (incorrect), and the third page has correctly used a Page Break

[image: ]Because a Page Break has been used, we can edit the document before this break in any way that we want, and this page’s formatting will be preserved no matter what.
The title will always be at the top of the next page and everything after it will be secure.
Because the Enter key has been used, if you add or delete any words/lines/images etc on this page before, everything on the second page will get pushed around and you may not even know!

The title on the second page was originally at the top but has been moved without our permission/knowledge because we added lines on the first page.
















Page Breaks are very useful, but of course if you are just typing normally and it wraps around to a new page this is fine!


To Start a New Document

On the Ribbon, click File, New then choose Blank Document.





[image: ]These are Templates. Pre-made documents with a specific layout for what you require. You just use the template and fill in the gaps. You can even use the search bar to look for more online, or create your own custom template (a later lesson)





If you want a new blank document instantly, you can also press Crtl+N.

It’s probably also a good idea to put a New Document button on the Quick Access toolbar so that you can do it with one click. 

The Quick Access Toolbar is the row of icons in the top left corner of the window. It is always visible and can house numerous functions that you use frequently.






Either right click on the toolbar and choose “Customise…” or click on this drop down arrow and make sure “New” is selected.

You can also add whatever else you want!

[image: ]




Highlighting Text

Type about 3 lines of text.
· Place the cursor just to the left of the text i.e. just outside the left margin. It should be an I-beam. (If you move the cursor too far to the left it will become a broad arrow.





[image: ]

Holding down the left mouse button, carefully move the mouse to the right, thereby highlighting the text. If you move off track and everything seems to be getting highlighted don't worry - DON'T LET GO- it's only where you start and finish that's important - not where you travel in between.

You should end up with something like this:
[image: ]

If you want to take off any highlighting, click anywhere.

Deleting Highlighted Text

Press the Delete, or Backspace Delete key.

Undeleting
Click on the Undo button on the Quick Access Toolbar: [image: ]
You can also use the shortcut Ctrl+Z but make sure you only press Z once!
Be careful – only use the undo button to undo something you have just done, not something 5 minutes ago as you will undo everything in between! Try not to use it as a delete button.

A few extra highlighting tips!

· Double click on a word to highlight it.
· Triple click to highlight a whole paragraph. (Recall that every time you press Enter you start a new line – and paragraph!)
· Click once in the margin to the left of a line to highlight the whole line. The cursor should be a white arrow before you click.
· You can also use this method to quickly highlight numerous lines by clicking in the margin and dragging vertically down.
· Put your insertion point somewhere, and hold down the Shift button and use the left and right arrow keys to quickly highlight individual letters!


Changing the font, font size and colour etc

You can now experiment with changing the appearance of your text by highlighting some and using the options found in the Font area of the Home tab:

Click here to choose from a list of different fonts
Click here to change size. The two “A” buttons to the right increase and decrease the size in increments




[image: ]Use these to change the font to bold, italics, or underlined (or a combination!)







Note that if you change to bold for example it will be bold FROM THEN ON. If you just want to make a small bit of text bold in your document, highlight it as above first.



You can also click on the small arrow in the bottom right hand corner of each subsection of the ribbon to open up a dialog box with more options:





[image: ][image: ]



Tip: to return the DEFAULT formatting in Word, press Ctrl+spacebar. For example if your text formatting is currently Bold, Italics etc then pressing Ctrl+spacebar will return it to your "default formats". You can also press this button – the A with the rubber - in the Font area!













Format Painter:

[image: ]

Select some formatted text - It may be bold, red underlined etc. Click the format painter button shown above. Click or select some text to which you wish to apply it. It should take on the same formatting. (Hint: To keep applying the formatting double-click the format painter button. To stop it, click on the format painter button again.)

AutoCorrect 
Sometimes when you spell a word slightly wrong, word will automatically change it to its correct spelling for you. This is called AutoCorrect. It also works in some instances when you need a specific combination of keys to produce a symbol, for example the © sign is created by typing ( c ) (with no spaces). 

To see/edit this function click on File, Options, the Proofing tab and then AutoCorrect. You can see what settings are already in place, and even make your own custom ones!

[image: ]

Moving Highlighted Text

· Highlight the text that you wish to move.

· Click again on this text and drag it to where you now wish it to be. (note that small, thick vertical line is the line which tells you exactly where the text is going to appear.)

· Release the mouse button.

Alternative methods:

1.
· [image: ]Highlight the text. 
· On the Home, Clipboard tab click the "Cut" icon with the scissors next to it. This will “cut” the text and place it in an invisible storage space known as the Clipboard. 
· Position the cursor to where you wish the text to appear by clicking.
· On the Home, Clipboard tab, click the "paste" icon. 


2. 
· Highlight the text.
· Press Ctrl+X. This is the keyboard shortcut for “Cut”
· Position the cursor to where you wish the text to appear.
· Press Ctrl+V. This is the keyboard shortcut for “Paste”. Useful to remember!


(If you forget these Ctrl codes, hover your mouse on the respective icon and it will tell you the shortcut).

3.
·  Highlight the text.
·  Click on the highlighted text with the right button – the Shortcut menu appears.

 [image: ]Note that the spelling needs to be correct for this method to work. This is because right-clicking in general produces a "context-sensitive" menu" ie word gives you the menu that it thinks that you need at the time and if the spelling is not correct, it will give you the spell-check menu instead of the Cut-Paste menu as shown here.


· With the left button, select Cut.
· Position the cursor to where you wish the text to appear.
· Click again with the right button.
· With the left button, select Paste.

Copying Text

Note the difference- moving deletes the original but copying leaves the original intact.

· Highlight the text. 

· Hold down the Ctrl key and don't let go.

· Click again on the highlighted text and drag it to where you now wish it to be.

· Release the mouse button and then the Ctrl key. (in that order)

Alternative Methods for copying text.

1.  As for moving but use the Copy instead of the Cut from Home, Clipboard tab.
[image: ]
2.  As for moving but use the "copy" button instead of the "scissors" button.

3.  As for moving s Ctrl C instead of Ctrl X. 

4. As for moving but use the Copy instead of the Cut from the Right Click Shortcut menu.

Summary:
We always must always choose Paste last.
The choice we make have to make at first is between cut and copy.
This may take a bit of getting used to.


Always Paste last. (And click on the main image of the clipboard – if you click on the drop down arrow below it will give you other options for pasting which are only used in specific circumstances

[image: ]
· Choose between Cut and Copy.









The difference between deleting and cutting.

If we delete highlighted text (by pressing the Delete key, it is “gone forever”.

If we cut the text by any of the 4 methods, it goes into the clipboard. The clipboard is a special section in the memory of the computer. Whatever is in the clipboard will stay there until it is replaced by some other text (or image etc) which you cut . Every time you do a paste, whatever is currently in the clipboard will be pasted into your document.


To Print a Document

· Choose File at the top left and then Print:

Choose the options to print many copies, certain pages only etc.

[image: ]Then Print.


In this “Print Preview” mode it also gives you a preview on the right hand side of the document. You can scroll through the pages, and zoom in and out to see what your document will look like when it is printed. 

Remember that all the formatting icons which are visible when you have the Show/Hide button on will not show up when you print!



To Save a document

· If you have not saved the document before, click on File and Save As... on the Ribbon.

[image: ]On the right hand side it will give you a list of recent folders which you have used in Word, in reverse chronological order with the most recent first. 

You can click on one of these to directly take you to that folder to save the document in there if you want.


To navigate to a certain folder in a more traditional method, click on Browse.

The Save As dialogue box appears:

[image: ]

Note that Word has tried to guess a file name by using the first few words of your document.

· Type the name you wish to use e.g. junk.
The extension.docx is added automatically if you didn’t include it so that the document is saved as junk.docx. (If your document is to contain macros it must have a .docm extension.)
(In Word 2003 the extension was .doc.) This tells your computer that it is a Microsoft Word document

· Click Save. (Make sure you take note of where you have saved it! Try and save it in the Documents folder for starters)

Note that the name of the document e.g. junk.docx should appears at the very top of the screen.
Previously it would have been Document1 or something similar.


· Close your document. (File, Close, or clicking on the X in the top right hand corner)

· Open your document. (File, Open)
· If you only had one document open in Word, the whole program would have closed. If that is the case you need to restart Word again.

· Make a small change to your document.

· Save it again using File, Save.

· Close your document. (File, Close)

· Open your document. (File, Open)
What do you see? – the latest version of your document- your previous version has been lost forever! The latest version has been "saved over" the previous version

If you wished to retain your 1st version, you would need to save the 2nd version with a new name. 
To do this you would need to choose File, Save As and choose a new name (eg junk1).
· Try it.



To Save a document onto a Flash Drive
[image: FlashDrive] 


These plug into a USB port. A USB port is the squarish socket at the front/back of the computer, or on the side of your laptop

[image: MacBook-Pro-USB-port]A USB port is an “intelligent” socket that interrogates the equipment attached to see what it is!



· Plug it in.

You may get dialog boxes appearing automatically. Cancel these for the moment.

You may also get a message telling you that new hardware is installed.

· Click on File and Save As... on the menu bar.

[image: ]


· Choose the drive. Usually D/E/F/G: or something similar. (The colon means “drive”).









· Make sure that the document has a name.





· Click Save.







Once the document has been saved, it could be transferred to another computer but before removing the flash drive from the port, it is necessary to “Safely Remove the Device” as follows:

· Hover the mouse over the little upward arrow icon similar to this one (at the bottom of the screen on the task bar on the very right hand side.) and then click.
· Some options similar to the ones shown should appear. The one that looks like a USB stick (highlighted in the image) is the one to safely remove the device

[image: ]









· Click on “Safely Remove Hardware” which then appears and follow any further instructions.

Revisited: The Difference Between Save and Save As

Choose File Save As: When you first save a document.
[image: ]
From then on choose File Save. (Instead of File Save, you could simply click “floppy disc”!  button. 


This button image is misleading. We are saving onto the hard disc!

As you will notice, this is a silent operation – nothing seems to happen – beware! you may be saving something undesirable over the top of your masterpiece and it will be lost forever.

Summary:

Choose File, Save As:
To save for the first time, or when you are changing drives or saving a separate version of the same document with a new name.

Choose File, Save:
When saving the latest version of your document and you don’t want the old version any more.

(It is possible to erroneously choose File, Save when you first save a document because Word simply brings up the File Save AS dialog box despite your contrary attempt. Try it. You could indeed simply click the Save button.) 

Hard Disc.


When we are doing a SAVE we are saving on top of the previous version.
When we are doing a SAVE AS are saving to a new location. (we will now have two files in different locations)














Text Alignment

Type a bit of text and highlight it.



[image: ]· From the Paragraph group on the Home tab click the Center button.


From the Paragraph group on the Home tab click the Center Alignment button (the second one)




The text should whiz across to the centre of the page. This is useful for titles/headings etc. With this setting on, whatever you type will spread out from the middle of the page. You can also use alignment with images, tables etc.


[image: ]


Click the Align Right button and this text should move to align the end of each line with the right margin. An example of this application is the address etc in the top right hand corner of letters:

[image: ]


The fourth button is a column alignment. This aligns both the left and right hand sides of the text with each margin in a straight line. This is rarely used in normal documents but is applied when you separate your text into columns.

Note: In recent versions of Word you don’t have to highlight the text anymore. You can simply place your cursor anywhere within the paragraph. (Remember: a “Paragraph” in Word is anywhere in between two places you have pressed the Enter key!)

Note: when you have changed the alignment and then press enter, the next line (paragraph) will keep this alignment. You have to manually switch it back to the standard left alignment (first button)

The four alignment buttons:

[image: ]

[image: ]

[image: ]



To get more options as shown here on the right, click the little arrow in the bottom right corner of the Paragraph group. This “extra options” button is on almost all the various areas of the ribbon – go have a look!

















Setting Custom Tabs

It is a good idea if you start a new blank document. (Crtl+N shortcut or File, New etc)

Setting Left Tabs

Make sure that the ruler is visible.
(If not, click View and then Ruler on the menu bar or Ribbon.)

· To set a left tab at 5” click just beneath the 5 on the ruler at the top of the page.
A small L should appear beneath the 5.(see the diagram below)

(If you make a mistake and place a tab where you don’t want it, you can drag it left or right into the correct position. If you want to delete it, drag it down off the ruler using the mouse.)

· Set another left tab at 10”.

· Make sure that your cursor is at the start of the document.It is not often that you will need to set a custom tab. It is more likely that you'll just want to know what these funny little marks are - esp if you click the ruler by mistake.

But, if you want to have multiple lines of text in specific positions like in the image, it can be useful.


· Press the tab key to tab to the 5” tab. You only have to press tab once!

· Type a few letters.

· Tab to the 5” left tab and type some more letters.

· Press Enter.

· Tab across to the 5” and 10” tabs and type some more.

You should now have something like this: 


[image: ]

Notice again with the Show/Hide button you can clearly see that you have only had to use one tab each time!




Paragraph Indent 


This paragraph is not indented. xxxxxxxxxxx xxxxxxxxxx xxxxx xxxxxxx xxxxxxx xxxxxx xxxxx xxxx xxxx xxx xxx xxxx xxxx xxxxx xxxx xxxx xxxxxx xxxxxxx xxxx xxxxx xxxxxxx xxx xxxxx xxxx xxxx xxx


This paragraph has only the first line indented. xxxxxxxxxxx xxxxxxxxx xxxxxxxxxxxxxxxx xxxxxxxxxxxxx xxxxxxxxxxxxx xxxxxxx xxxxxxxxxx xxxxxxxxxx xxxxxxxxxxx xx
xxxxxxxxx xxxxxxxxx xxxxxxxxx xxxxxxxxx xxxxxxxxx xxxxxxxxx xxxxxxxxx xxxxxxxxx xxxxxxxxxx


This paragraph is left-indented. xxxxxxxxxxx xxxxxxxxx xxxxxxxxxxxxxxxx xxxxxxxxxxxxx xxxxxxxxxxxxx xxxxxxx xxxxxxxxxx xxxxxxxxxx xxxxxxxxxxx xxxxxxxxx xxxxxxxxx


This paragraph is left-indented but also has the first line left-indented. xxxxxx xxx xx xxxxxx xxxxxx xxxx xx xx xxxxx xxxx xxxxxx xxxx xxxxxxx xxx xxx xxx xxxx xxxxx xxx xxxxxxxxx xxxxxxxxx xxxxxxxxx xxxxxxxxx xxxxxxxxx xxxxxxxxx


This paragraph is right indented. xx xxxx xx xx xxx xx xxxxx xxxxxx xxxx xxxx xxxx xxxxx xxx xx xxx xx xxxxxx xxx xxxx xxx xxxx xx xxxx xxxxxxx



Remember: A new paragraph is defined when the Enter key is pressed!

The simplest way to adjust the paragraph indent is to drag the indent-markers which are on the ruler. Be careful though – you will need to drag different sections of it for different purposes.

[image: ]

· To set the first line indent, carefully drag the top triangle a few inches to the right. This only affects the first line.

· To set the left-indent carefully drag the tiny rectangle on the bottom to the right a bit and then type a paragraph. This indents the main body of the paragraph. (And the first line if you haven’t changed it)

Note that you can drag the top and bottom little triangles independently but by dragging the tiny rectangle, both the little triangles are moved, and any indent between the first line and the main body is conserved.


· Set a right paragraph indent by carefully dragging (only) the tiny triangle on the right of the ruler bar.

	Be careful not to also drag the right “margin setter”)

[image: ]Note that if you set the paragraph markers, these markers will apply from then on until you change them back. You do this by either dragging the shapes back to their original position, or you can use the Clear Formatting button discussed earlier. 

Note that if you place the cursor in a paragraph that you have already typed, the settings will immediately be indicated by the paragraph- indent indicators on the ruler bar.

If you wish to change the indent settings for a paragraph, place the cursor anywhere in the paragraph. (there is no need to block the paragraph off- though you could if you wished.) and simply drag the indicator. The settings for that paragraph only will be changed.
(When you set paragraph indents they apply to the particular paragraph whereas recall that margin settings apply to the whole document.)
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